USB to RS-485 Adapter
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UTS-485Ul (RJ-45 Male Connector)
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1. Introduction

USB to RS-485 adapter provides an extra Serial Com port via USB connection and can be configured to work
with RS-485 peripherals such as POS and Industrial Control devices. USB to RS-485 adapter allows configuring
such as Echo through application software. Termination Resistors and Bias can be set as good solution for
saving time without manual setting. It supports USB Plug and Play; and serial port expansion. No IRQ, DMA, or

I/O port resources required.

Features:

»  Echo mode/Bias resister/Terminal resister set up by Windows application program, Mac or Linux OS

compliant
»  Supports Data transfer rate up to 3M Baud
»  Supports plug and play and hot swappable function
»  No external power supply required
»  Supports £15Kv ESD protection (HBM)
»  Allows single unit connecting up to 32 devices on the network
»  Compatible Windows OS 98SE / ME / 2000/ XP / Vista /7 /8 /8.1 /2003 /2008 / 2008R2 / 2012 / 2012R2;

Win CE OS, Mac OS 8.6, Linux OS 1.5.0 or higher.
»  Fully Compliant with USB specification 1.1 and 2.0
Specific:
Model No. UTS-485Ul RJ-45 Pin Assignment
Chip FTDI Pin 1 D+
Data Transfer Rate Up to 3M Baud Pin 2 D- —
USB Specification USB 1.1/ 2.0 compliant Pin 3 NC

Upstream USB Type A Male Pin 4 NC
Connector - -
Device 8P8C RJ-45 Male Pin 5 NC g

Cable Length 2m Pin 6 NC L
Power Mode Bus Powered Pin 7 NC i (R
Housing Plastic Pin 8 GND
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2. Installation
To install the UTS-485Ul AP software, please confirm the points below:

a. The demo steps are operated on Windows

b. Make sure that Microsoft .NET Framework 4 version is installed on your computer
To download it, please visit its official website:
http://www.microsoft.com/en-us/download/confirmation.aspx?id=24872

c. Install the program with administrator privileges.

d. Make sure the device driver is installed.

Note:

FTDI Chip drivers can be downloaded and setup with Windows OS 2000 or higher by Windows Update. To
update drivers, please unload old version, then re-plug device, Windows Update will detect and update
automatically. (Above requires internet connected). Any unknown problem while installing, please install the
driver from CD, you can refer to page 13.


http://www.microsoft.com/en-us/download/confirmation.aspx?id=24872
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Steps:
1. Double click the RS-485_AP_Installation_V13.10.1.msi to install

RS5-485_AP Insta
llation_W13.10.1.
msi

2. Click “Next” to continue

[ 8 Rs-a85 AP ESNEE )

Welcome to the R5-48b AP Setup Wizard A

The ingtaller will guide vou through the steps required toinstall B5-485 AF on your computer.

WARMIMG: This computer pragram is protected by copyright law and international treaties.
IInauthaorized duplication or distribution of this program, or any partion of it, may result in zevere civil
or criminal penalties, and will be prosecuted to the maximum extent pozsible under the law.

Cancel < Back
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3. Select install folder or use default, click “Next” to continue.

(8 Rs-285 AP o |

Select Installation Folder [_‘I

The ingtaller will ingtall BS5-485 AP to the following folder.

Toinztall in this folder, click "Mext”. Taoinstall to a different folder, enter it below or click "Browse"',

Folder:
C AP0 greum Files RE-485 APy [ Browse... |
| DiskCost.. |
Install B5-485 AP for yourself, or for anyone who uses this computer:
@ Ewverpone
71 Just me
Cancel ] [ < Back ] | Mest =
4. Click “Next” to start installation
) RS-485 AP . ESNEE
Confirm Installation =l
P ]
The ingtaller iz ready to inztall B5-485 AF on vour computer.
Click "'Mext" to start the inztallation.
Cancel ] [ < Back ] [ MHest =
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5. Please wait 2~3 min until the installation is completed

[ 8 Rs-a85 AP . ESNEE )

Installing R5-485 AP A

F5-485 AP iz being installed.

Pleaze wait...

< Back Mest »
6. Click “Close” to exit.
4l Rs-485 AP . ol |
Installation Complete =l

F5-485 AP has been succezzfully installed.

Click. "Claze" ta exit.

Fleaze usze Windows pdate to check for any critical updates to the MET Framework.

Cancel < Back
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3. UTS-485Ul Application Operation

“RS-485 AP Logo” Icon should appear on the desktop, double click it to start

(Please refer to p.13 for the driver’s installation)

. After the ‘RS-485 Device Manager’ screenshot ap pears, connect UTS-485Ul device

B R5-485 Device Manage

I Device selection

RS-485 Application
= Echo Enable = Echo Disable

) Echo+Terminal = Terminal
© Echo+Bias © Bias

) Echo+Terminal+Bias = Terminal+Bias

START
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2. RS-485 Device Manager will detect all UTS-485Ul devices connected to the PC, click “Device selection”

drop down to select device.

Check Statos

& R5-485 Device MManager [ = é,l ]
Device zelecton Berial Mo,
—
RS-485 Application
) Echo Enable ) Echo Disable
) ) Echo+Terminal @ Terminal "
) Echo+Bias ) Bias
| |
) Echo+Terminal+Bias ) Terminal+Bias
Status

START

3. In this case we may select Device01, and then it may detect and show its Serial No. automatically.

o Echo+Terminal+Bias

I Statos

Check Btatus

[ d& RS5-485 Device Manager ‘Elﬂlg
Device selechon werial Mo,
= DEWESOCI
RS-485 Application
) Echo Enable 0 Echo Disable
) Echo+Terminal 0 Terminal
© Echo+Bias © Bias

o Terminal+Bias

START
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4. Operation for setting Device01: click ‘Echo+Terminal’ for the device’s application setting and then click
“START".

3 RS-485 Device Managel

Device smlection Berial Mo,
Dievicel1 - DEWBROCI

RS-485 Application
= Echo Enable ) Echo Disable

@ Echo+Terminal ) Terminal

) Echo+Bias = Bias

= Echo+Terminal+Bias

) Terminal+Bias

START

5. Wait until the block of the ‘Serial No.’ displays blank, and you have finished the device’s application setting
successfully.

d8: R5-485 Device Manager

Device slection

Devicell1 -

RS-485 Application

i 0 Echo Enable @ Echo Disable

@ Echo+Terminal ) Terminal

) Echo+Bias ) Bias

) Echo+Terminal+Bias ) Terminal+Bias

Status Succesfullr setl!

START

10
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6. To confirm device’s application setting, while UTS-485UlI is still connected to the PC, Select device again then
click “Check Status”.

3% R5-485 Device Manager

h Device selection Serial Na.
Dewicell = DEWESOCI
RS-485 Application
i ) Echo Enable = Echo Disable
@ Echo+Terminal = Terminal

= Bias

© Echo+Bias

) Echo+Terminal+Bias 2 Terminal+Bias

Status Echo+ Temminal Resster

START

Congratulation! You have finished setting the UTS-485UI device successfully.

11
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4. Uninstall

1. Enter “Control Panel” and click ‘Programs’ to uninstall a program. Locate the ‘RS-485 AP’ and click to
uninstall.

48 Realtek Ethernet Controller Driver Realtek

[8° Realtek Ethernet Diagnostic Utility Fealtek

3 erreErefinition Audio Driver Realtek Semiconductor Corp.

18102013
= playe = Skype Technologies S.A
[m7 SmartCard Reader Driver Installation Alcor Micro,Crop.
[E75T Toaolset STh

2. Click “Yes” to remove.
Note: If you fail to uninstall the RS-485 AP, please unplug the device and repeat above operations again or
reboot your computer and then uninstall.

R5-485 AP

=

| Please wait while Windows configures R5-485 AP

] | Cancel

12
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5. Driver Installation
Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)

The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.
OS requirements: Windows 7/8/8.1 or later.

Please go below ways for easy installation.
1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from the

taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

;B Installing device driver software * *

Click here for status.

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

Installing device driver software

Generic USB Hub Y to Use
USE <-» Serial i_d Searching Windows Update.., I

Obtaining device driver software from Windows Update might take a while,
Skip obtaining driver seftware from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

F
_'_! Driver Software Installation

Installing device driver softwagg

USB <-> Serial | (& Searching preconfigured driver folders... II

Fig. 3

13
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5. Then it shows ‘USB Serial Port (COMS) installed’. Click ‘Close’ and go next step. (Fig. 4)

A Driver Scftware Installation

Your device is ready to use

LIZE Serisl Converter f Beady ta use
USE Sensl Port (COME) JRead,"Io wse
Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMB8)
under ‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus controllers’.
(Fig. 5) Congratulation! You have finished installing the USB to Serial device successfully.

r:é Device Manager e E@Iﬂ
File Action View Help
e @ E HE® @RS

- ¥ Metwork adapters -

. I Portable Devices
477 Ports (COM & LPT)

= USB Serial Port (COMS)

-2} Processors
» % Sound, video and game controllers

| > M Systemn devices
a- ﬁ Universal Senal Bus controllers
.| Generic USB Hub
t E Generic USE Hub
- §§ Generic USE Hub
@ USB Reot Hub
.| USE Reot Hub
- §§ USB Reot Hub
- § USB Reot Hub
.| USE Reot Hub
.. §f USB Reot Hub
USE Root Hub

m

UsSb oot AUD
E USE Serial Converter =
Y ~ S S [y | S 3 Voo PO N o F o |

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.

1. There is busy on access databank of Microsoft’'s Support link. Please try again or install driver of CD-ROM
provided.

2. Check your internet if it is failed to access Microsoft’'s Support link.

3. Check your computer configuration if it is disabled on Windows Update wizard.

J Oriver Software Installation l

Device driver software was not successfully installed

Phease condult with your device man rer for assatande getting the denllinstalled

| LS e Sarual X M drvcer found

What can Lde o oy devies ded et ksl pregetly

14
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Windows 98SE Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.
Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware
Wizard. Windows may display a message reading "Building driver database" at this point which may take a
few minutes to pass. Click "Next" to proceed with the installation.

Add New Hardware Wizard

Thiz wizard searches fol new drivers for:

IISB <-» Serial Cable

& device driver iz a software program that makes a
hardware device work,

¢ Baok

Cancel |

Select "Search for the best driver for your device. (Recommended) as shown below and then click "Next". -

Add Hew Hardware Wizard

‘Whal do vou want Windows to do?

% Search for the best diver for your device. |
[Recommended).

& Display a list of all the drivers in a specic
lnzation, g0 you can select the driver pou want,

< Back I Mewt » I Cancel

15
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Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and
locate the driver files. Once the files have been located, click "Next" to proceed with the installation.

Add New Hardware Wizard |

“iindows will search for new drivers in its diver database
on your hard drive, andin any of the following selected
locations, Click Mest ta start the search.

[ Foppy dizk drives
[T CO-ROM drive
[ Microsoft Windows Update

¥ Specify a location:
|c:n =]
Browse... |

< Back I MNext = I Cancel |

Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard I

“winoows driver file search for the device:

[15B Serial Corwerter

"Windows iz now ready b install the best diver far this
device. Click Back to zelect a different driver, or click Mest
to continue.

Location of driver:

= CAYCPDRITIMFTDIBUS.INF

< Back

Cancel |

16
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If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request
a driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Inzert Disk

Q Pleaze inzert the diz< labeled 'FTOI USE Drivers Digk!, and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without
the .CAT file, click "Skip File".

Inzert Dizsk
The file ftdibuz.cat on FTO LISE Drivers 0K
g_l Dizk cannat be found.

Cancel

Inzert FTDI USE Drivers Dizk in the selected
drive, and click OF.

Skip File

Dietails...

Loow files from;

CWEP Drivers j Browse...

PEE RN

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver was
successful. The COM port emulation driver must now be installed. Click "Finish" to complete the installation
of the serial converter and proceed to the COM port emulation driver.

17
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Add New Hardware Wizard

% [15B Sernial Converter

Windows has finizhed inztalling the software that your new
hardware device requires.

¢ Hack

Catcel |

Under Windows 98SE, the COM port emulation driver will be automatically installed from the same location
as the serial converter driver. However, if the driver is not WHQL certified as explained above for the serial
converter driver, the wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message

box.

Ingert Disk ] |

Q Fleaze inzert the dis< labeled 'FTDI USE Drivers Disk', and then click OF.

18
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The following window will appear to assist in locating the file. To proceed with the installation without
the .CAT file, click "Skip File".

Inzert Disk

T he file 'ftdiport. cat' on FTDI LUSE Drivers 0k,
\ﬁ Disk cannot be found.

Cancel
|nzert FTDH USE Drivers Dizk in the selected
drive, and click OF.

Skip File

Details...

j Browse...

LCooy files from:

UGS

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the "'Device Manger" tab) and
select "View devices by type". The device appears as an additional COM port with the label "USB Serial
Port".

Syetem Properties EE

Generdd  Device Manager !Hardﬂarel’rnﬁlssl Perfomancs |

% iaw devices by bppe " Vigwe dendces by connection

#-#8 Keyboad |

-l Wodsrn

5] Morbors

7y Mouse

- MUkl OConrcller

B3 Metwok adapber:

=% Pors [COM & LPT)

[ Commerications Port [COM1)
~# PCIECP/EPP Par [LPT1)

<o PCl Genial Pait [COM2)

& - E- 3

[T

B Syshem devices
Untverzal Serizl Bus corgrollers

Universal Serial Bus contiollzes

-H

]

+

i1

Fropestas I Refrezh I Rencre I Prnt... r

[ ] ranee |

19
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or

appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".

20
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Uninstalling Instruction

To uninstall drivers, follow the instructions below:
Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control PaneNAdd/Remove Programs". Select "FTDI

USB-Serial Converter Drivers" from the list of installed programs.

Add/Remove Programs Properties |

Install /U nirstall I Windows Setup I Startup Digk I

% To rztall a new program from a floppy dizk or CO-ROM

drive, chick [nztall
Irstall...

lﬁ% The fallowing software can be automaticall rermoved by
)

YWindowsz, Toremove aprogram or bo modiy itz installed
components, select it from the lizt and click
Add'Remove.

Chineze [Traditional] Language Supy
(FTDI LISE-to-Senal Coreeerter Dirvers
[etRight

IngtantCD AOVD J
|nterret Explorer Q828750

Japanese Language Support
F.ernelliiver

Ky Drive 1.0 _I

K.orean Language Support
Add/Femove... |

ok | Cemeel | dppb |

21
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Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the
uninstaller or "Cancel" to exit.

FTDI Uninstallzr v3.0 ]|

If your USB device 12 connected, please unplug it now.__

Prezs Continue to uninstall the driverz. or Cancel to quit.

Continue |

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button
will change to "Finish". Click "Finish" to complete the process.

FTDI Uninstallzr v3.0 ]|

Uninstalling VID_0403%PID_6001

Deleting registiy entries.__
Deleting Hles...

Uninztall complete. presz Finizh to exit.

[Eatirue |

22
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Troubleshooting

1. Windows 98SE cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USBView utility from the FTDI website. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed the VID and PID entries in the driver
INF files. If they do not match, that driver cannot be installed for that device without either re-programming
the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note that only your
own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your company should be
used in the EEPROM and INF/INI files.

2. Windows 98SE forces areboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the
computer then unplugging and re-plugging the device may allow the device to function properly without
restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 98SE gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed. Please refer to the example schematics on the FTDI website for standard device
configurations. If the error persists, please contact the FTDI support department.

4. Device hangs randomly during operation under Windows 98SE
This is not caused by the driver, but is a hardware compatibility problem. Some newer USB 2.0 hubs and
host controllers can be susceptible to noise and can cause random device failures. This can be overcome

by fitting 47pF capacitors to ground on the USBDP and USBDM lines on the USB connector side of the 27W
series resistors.

23
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5. Windows 98SE complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL
certified. If a driver is not certified, there will be no .cat files available. When installing drivers in Windows
98SE or Windows ME, the user is prompted to locate the .cat files if the operating system cannot find them.
If the driver is not certified but you wish to install it anyway, the files may be skipped by clicking the "Skip"
button.

6. Windows 98SE complains about missing ftccomms.vxd file
This can occur when the USB Composite driver has been installed if the user has not browsed to the

location of the driver files. If this message appears, do not skip it but browse to the driver file location. The
wizard will then be able to correctly install the device.

24
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the
Found New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found Mew Hardware Wizard

Welcome to the Found New

% Hardware Wizard

This wizard helps vou install a device driver far 2
hardware device.

To continue, click Mest.

¢ Back I [ et | Cancel

Select "Search for a suitable driver for my device (recommended)" as shown below and then click "Next".

25
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Found New Hardware Wizard

Install Hardware Device Drivers
A devica driver iz a software program that enables a hardware device to work, with
an operating system.

Thiz wizard will complete the installation far his device:

@ LISE <= Serial Cable

A device driver i a saftware program that makes a hardware desvice work, Windows
needs diver files for your new device. To lozate driver files and complete the
iniztallation click Mest.

What do pou want the wizard o do?
& Search for a suitable driver for my device [recommended)

£~ Dizplay a list of the known drivers for this device zo that | can choose a specific
driver

¢ Back I A [=H I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a

dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard

Locate Driver Files
YWhere do pou want Windows to gearch for driver files?

Search for driver fileg for the fallowing hardware device:

@ USE <-> Serial Cable

The wizard zearches for suitable drivers in itz driver databaze on your computer and in
any of the following optional search location: that you specify.

To gtart the search, click Hest. [f you are zearching on a floppy dizk or CO-ROK drive,
inzert the floppy disk ar CD before clicking Memst.

Optional zearch locations:
[ Floppy digk drives
[~ CO-ROM drives
¥ Specify a location
[ Microsoft Windows Update

< Back I P et I Cancel

26
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Found Mew Hardware Wizard R |
[nzert the manufacturer's inztallation disk into the drive g |
g zelected, and then click OF.

Cancel

Copy manufacturer's files from:

C:ACDM 2.00.00 x| | Browse.. |

Click "Browse" to display an open file dialog box.

Lock ir: |- CDM 2,00.00 ~| « @&k E-

op

e

by Documents

g Het

File narme: IFTDIELIS.INF j Open I
LI Cancel |

Files af type: |Setup ImFarmation %]

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open”,
then click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows has found the required driver .INF file, click "Next" to proceed.

27
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Found Mew Hardware Wizard

Driver Files Search Results
The wizard haz finished searching for driver files for your hardware device.

The wizard found a driver for the following device:

@ USE <=+ Serial Cable

Windowsz found a drver for thiz device. To netall the dhiver Windows found, click Mext.

g chedm 2. 00.00%dibus. inf

¢ Back I Mest = I Cancel

Windows should then display a message indicating that the installation was successful. Click "Finish" to
complete the installation for the serial converter driver for this port of the device. The COM port emulation
driver must be installed after this has completed.

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

e USE Senal Conwerter

“Windows has finshed installing the zoftware for this device.

To close thiz wizard, click Finizh.

Bk lm [Eantel

28



USB to RS-485UI Adapter User’s Manual

By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and
click "Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears
as a "USB Serial Converter" with an additional COM port with the label "USB Serial Port".

-—4 Device Manager ; ._L.j- ]S |
| acton gew || = = (@@ (@@
- B Tntel(R) 52501EE LPC Interface Controlle: - 2400 -]

=) [ Inbel(F) B2601EB FCI Bridgs - 244E

© o HD Intel(R) PROJ100 YE Network Conneciion

i BB Realtek RTLE139/810x Farmily Fast Ethernet MIC

i B Irtel(F:) 526016 SMBus Controller - 2403

#-52 IntellR) S2801EE Lkra ATA Storage Controliers

52 Intel() B2501EB Likra ATA Storage Contiokers

= InteliR) G2E01EE USE Universal Host Condroller - 2402
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove
Programs utility as this uses the FTDI driver uninstaller program to remove files and registry entries to leave
a clean system. Other methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs ".Select "FTDI

USB Serial Converter Drivers" from the list of installed programs.

f-'ﬁl; Add/Remove Programs

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue” to run the

uninstaller or "Cancel" to exit.

FTDI Uninstaller ' ] X|

ITyour USE device is connected, please unpluyg it now ...

Press Continue to uninstall the drivers, or Cancel to quit.
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When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button
will change to "Finish”. Click "Finish" to complete the process.

FTDI Uninstaller — B X|

Uninstalling ¥ID_0403&PI1D_ 6010

Deleting registry entries ...
Deleting files ...

Press Finish to exit.

31



USB to RS-485UI Adapter User’s Manual

Troubleshooting

1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USBView utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either
re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please
note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plugging the device may allow the device to function properly without restarting. Restarting the machine
will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being
incorrectly installed. Please refer to the example schematics on the FTDI web site for standard device
configurations.

4. The device hangs randomly during operation under Windows 2000

This is not caused by the driver, but is a hardware compatibility problem. Some newer USB 2.0 hubs and
host controllers can be susceptible to noise and can cause random device failures. This can be overcome
by fitting 47pF capacitors to ground on the USBDP and USBDM lines on the USB connector side of the 27W
series resistors.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and
unzip them, the critical files in the driver package are:

ftdi_ser.dll - the VCP driver file

FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be
installed

Copy all of the unzipped files to the \Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host
card), make sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct
Windows CE to the driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is
incorrect, the driver will not be found and the device will not function.

| Enter the name of the device
1 driver for this device. For

information, see the device

manufacturer's documentation,

1231|234 |5]6|7]a8|9]0]-|=
Tablq|w|e[r|t|y|u|i]o|p]|l
CAP|a[s[d[f]a]h[j[k]]
Shift| 2z [x [c[v[b[n[m[,].]
ctlail * |\ | [4]2

"
I

The device installation is now complete. The installation may be verified using the test program
available form the Utilities page of the FTDI website.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is connected for the first
time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is
likely that the PDA does not have a USB host capability or that the host is not installed correctly. Many PDAs

require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card) to
provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

(¥ sunday, June 01, 2003
=] Tap here to set owner information

Error installing USE driver
ftodi_d2ux

New Tools Accounts Q % E|‘

The driver name has been misspelt. The ".dll" file extension may be required for some platforms. The
required driver files are not in the \Windows directory. The driver file is in the wrong binary format.
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

¥ Unidentified USB D o #x 12:17

(# sunday, June 01, 2003
[=] Tap hereto set owner information

=] Naupcoming appointments
| y Unidentified USB Device (ok]

New Tools Accounts [F =

The driver name has been miss pelt - The ".dIlI" file extension may be required for some platforms - The
required driver files are not in the \Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the VID and PID

combination programmed into the device. It can also be caused if the INF file has not been copied to the
\\Windows directory.

r; Unidentified USB D & #x 10:38

:; Unidentified USBD o #x 12:04

@ Sunday, June 01, 2003

(@ sunday, June 01, 2003

Unidentified USB Device Unident ified USB Device

B Enter the name of the device
dcriver for this device, For

% Enter the name of the davice
= driver for this device. For

' information, see the device

| manufacturer's docurmentation, 8| manufacturer's docurnentation.

fia dz- | | o e o I
[oc ] [Concei ] |0 ok ] [conce | fo
120[1[2[3[4[5[6[7][8[9]0]- =4 1231[2]3[4[5/6]7[8[9]0]-|=4
Tabjq[wle[r[t]y[u]ifo[p[[]] Tabjq[wle[r|t]y[ulifo[p][]]

CAPla|s|d|fT|g|h[j|k[1|7]" CAPla |s|d|f]|alh|j|k|V]:]"
shitjz [ [c[v[b[nlm[, [, [7]« chift|z [ [cv[bn[m],[. /]«
Ctfad] " [\] [4[t]e]~ Ctifai] " [\ | [4]t]e]>
| =8|
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable
registry editor on the Windows CE device itself) to check for the registry settings (Tools > Remote Registry
Editor). With ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

&' Windows CEHemote itegistry Edibor

- =10
Begstry ER Yew Covedwn Hep _laix
Do 7| T e _EJ 1 L S [ [
# = My Computer R
= - POTKET PC 2003 Dererc o

ot [ MEEY_CLASAES RicT
(= [ HEEY _CURRENT LISER
=10 HEEN_LACAL_MACHINE
* _'| Ceenin
E L] CotroPare
=10 Triamiz
I e
1 BultIn
41 Cesplay
3 1] FCMCIA
R ]
13 |20 SDCaRD
[3 ] Toshia

] FID_DEVECE_GOt0
E ] LnmiChents
1027 4500

s

121 Flaktam
w1 el
¥ 0] Securky
F 1] Sairvces
w4 5d
i (L] SOFTWSRE
+ ,__I Sribaim
=] Te

EPOCIET B2 2000 Devica|FREr_LOwnL_ HACHINGDrrer s 0 cad ke LIET_24592] E

37



USB to RS-485UI Adapter User’s Manual

In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010
(24592) device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX
drivers, edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw] "FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:

[FtdiHw] %VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010

5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely
a hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows
2000 and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer
sizes. One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible
transfer size and will have a severe effect on performance, but should resolve most other issues. Larger
values may be tried to improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device
running at a different Baud rate to the one intended. The Baud rate can be verified easily by transferring
data from PDA/target to HyperTerminal. Some host device drivers have been seen to lose packets of data
which would also cause this problem.

7. Driver isn't sending or receiving any data

Sending and receiving data can be tested with an application such as VCPTest. However, this will not

highlight problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer
data from the PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via the Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer to
the Uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This
can be done by either removing the network cable from your PC or by disabling your network card by going
to the "Control Panel\Network and Dial Up Connections", right clicking on the appropriate connection and
selecting "Disable” from the menu. The connection can be re enabled after the installation is complete. This
is not necessary under Windows XP SP 2 if configured to ask before connecting to Windows Update.
Windows XP SP 2 can have the settings for Windows Update changed through "Control Panel\System" then
select the "Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If the device is based on the FT2232, the Microsoft
composite device driver is automatically loaded in the background. Once the composite driver has been
installed Windows Found New Hardware Wizard will launch. If there is no available Internet connection or
Windows XP SP 2 is configured to ask before connecting to Windows Update, the screen shown in Figure
2.1 is displayed. Select "No, not this time" from the options available and then click "Next" to proceed with
the installation. If there is an available Internet connection, Windows XP will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually
selected.

Frumipned B e Herahoser = ¥ieard

Welcorme to the Found New
Hardhwara Wisard

Sl me mll s o aamed aodepdalad sollvsia by
lockirg ors g compde), or s haokasin el oo CD oo
thae S ndows Updale S sb sibe [ 1h wona pamis ol

Jia rigimsir
Car rird oy connoc! 1o afidou Uioadale e search o
anfus?

i ms this s arle
(e novs and mvse time | connect & device
Mo, Pl s s

Click = b portinus.

Figure 2.1

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".
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Select "Search for the best driver in these locations” and enter the file path in the combo box ("C:\CDM
2.02.04" in Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been

entered in the box, click next to proceed.

Funnnd Hew Harlware Wizail

Trws g pail Felps pon inetal snfvacee o

J3B Swid Coremile

“} IF vour haadwsse coames with an installstion CD
=2 or Boppe disk. insert it now.
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(50 el from o led o goescilic: bocaa o Pachranced]

Click Pt bo conlirue:

< Bach " M= | Cancel

Fumpnl v Harilware Wizard

Please chooae yown search and inztallamon opfions.
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Use o= check boees below i ini o aspend the dafeult smach, vhich ircudss lacel
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Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.
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Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click
"Finish" to complete the installation for the first port of the device.

If the device is based on the FT2232, the Found New Hardware Wizard will continue by installing the USB
Serial Converter driver for the second port of the FT2232 device. The procedure for installing the second
port is identical to that for installing the first port from the first screen of the Found New Hardware Wizard.
This is done automatically if the driver is Microsoft WHQL certified. If the device is not based on the FT2232,
the COM port emulation driver is loaded as indicated in the following steps.

The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As

above, select "No, not this time" From the options and click "Next" to proceed with the installation (Figure
2.7).
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Figure 2.6
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Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM
2.02.04" in figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been
entered in the box, click next to proceed.
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Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed,
the message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified
driver. Click on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file

signature warnings, no message will appear.

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.
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Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click
"Finish" to complete the installation for the first port of the device.

If the device is based on the FT2232, the second port must also be installed. The procedure for installing the
second port is identical to that for installing the first port from the first screen of the Found New Hardware
Wizard for the USB Serial Port device. If the driver is Microsoft WHQL certified, this is done automatically.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger") and select "View > Devices by Connection", the device appears as a "USB Serial
Converter" with an additional COM port with the label "USB Serial Port" (Figure 2.13). If the device is based
on the FT2232, two ports will be available from a composite USB device.
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Figure 2.13

In the case of the FT2232, port A of the FT2232 will be installed as COMX and port B will be installed as
COMX+1 where COMX is the first available COM port number.
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Figure 2.14
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2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using
the Microsoft Driver Install Frameworks (DIFx) tools. The simplest tool provided is the Driver Package
Installer (DPInst). When placed in the same directory as the INF files for the driver package, simply run
DPInst.exe and the certified driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has
separate executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit
and 64bit systems, the developer must be able to detect which version of DPInst is required for the system
the driver is being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via
The New Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a
device” option should be selected on the first screen of the wizard when asked if Windows Update should be
checked for a driver. If the wizard finds a matching driver on Windows Update, the driver will be
automatically downloaded and installed for the device.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device
Manager by simply right clicking on the device and selecting "Uninstall”. This will delete the associated
registry entries for that device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a
custom application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by
searching for a VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the
matching OEM INF files are found (e.g. oem10.inf for FTDIBUS.INF and oem1l.inf for FTDIPORT.INF), the
corresponding PNF files must also be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in
the Windows\System32 and Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

In the case of FT2232 devices, a composite device is also installed. This can also be removed by right
clicking on the composite device in the Device Manager and selecting "Uninstall".

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus
is removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work
correctly. This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the

missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer
has been removed first. Instructions on how to display phantom devices are given in the Advanced Driver
Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or madifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use
by your company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy
it. This usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and
re-plug the device may allow the device to function properly without restarting. Restarting the machine will
allow the device to work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a
device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices),
or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers being

incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error
persists, please contact the FTDI support department.

4. Windows XP Displays an Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the
installation of any drivers that are not WHQL certified.
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Hardware Installation

@ Thee software vour are wistallirag for thes hardware:
USE Senal Corverter

haz not pazzed Windows Logo testing to wenlfy s compatibifity
wath thes version of Windows. [Tell me why thas tezbing iz impostant]

This hardware will not be installed Contact vous system
ademrdstrator:

Lok |

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be
installed (if available) or the driver signing options can be changed to either warn or ignore to allow the
installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and
then click "Driver Signing". The desired signing option may then be selected.
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Windows Vista (Win 7, Win 8/8.1) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA will silently connect to the Windows Update
website and install any suitable driver it finds for the device in preference to the driver manually selected. If
no suitable driver is automatically found then the following procedure should be followed.

Windows needs to install driver software for your TTL232R
Tester

® Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device.

<+ Ask me again later

Windows will ask again the next tirne you plug in your device or log on.

® Don't show this message again for this device
Your device will not function until you install driver software,

When locate and install driver software (recommended)" is selected the following screen will appear. Note:
the text “TTL Tester” is replaced with the description of the customer hardware.

50



USB to RS-485UI Adapter User’s Manual

() L Found NewHardware - TTL232R Tester

Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software,

% Idon't have the disc. Show me other options.

Select “I don’t have the disk. Show me other options” The next screen will appear.
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Windows couldn’t find driver software for your device

+ Check fora solution

Windows will check to see if there are stepsyou can take to get your device
waorking,

+ Browse my computer for driver software (advanced)
Locate and install drver software manialby,

Select "Browse camputer for drver softeware (advanced)”. The next screen will appear.

”

Browse for driver software on your computer

Search for driver software i this location:
Hm G== N DeskioptC DM 2.00UKE (Cerified)

[ Include subfolders
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Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.

The next screen will appear

R T Found Mew Hardware - TTLX2R Testar

Instailing driver software..

This screen will automatically complete and then change to the one below:

u | Found New Hardware - USB Serial Converter

The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

USE Serizal Converter
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The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assigned to the device for
configuring the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manager”) and select "View > Devices by Connection”, the device appears as a" USB Serial
Converter" with an additional COM port with the label "USB Serial Port".

7 Device Manzger == s
File Action View Help

 ole Aol 7 Bk
o ﬂ!ii.al'—-t‘ _

+ | Camputer

iy Disk dnves

: ";-' Display adapters

7 gty OVD/CD-ROM drives
&4 Floppy disk drives

= Floppy drive controllers
= ¢FJ Hurman Tnteface Devices

- g [DE ATASATAR contrllers

i g IEEE 1354 Bus host contrellers

G & Keyboards

3 Ij Pice and other poinzing devices
& M Monitors

5 B Metwork adapters

K Portable Devices

T Perts (COM BLLPT)

e

Communications Port [DORL)

o

Y27 Printer Pom (LPTL)
T3 USB Senal Port (COM2)

F m Processors

=% Sound, video and game controflers
&, High Definition Audio Device

= 4> Storage conlrollers

21 System devices

£ § Universal Seial Bus controilers

This screen shows the device connected to COM3.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat
this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or
appropriate versions from FTDI Web site:

www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to
Windows Resource Protection preventing the executable from deleting driver files and associated registry
values. Vista will only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device
Manager by simply right clicking on the mouse and selecting "Uninstall". This will delete the associated
registry entries for that device only. Vista provides an automatic method to delete driver

Confirm Device Lininstall - S

LISE Senal Comnmvernter

Waming: You are sbout to uninstall this dewices from your, system .

=] Dslete the driver software for this devics_

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files
must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:

In the case of FT2232 devices, a composite device is also installed. This can also be removed by right
clicking and selecting "Uninstall". There is no option to delete the driver files when doing this as the driver for
the composite device is a native Windows driver.

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the
bus is removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly.
This can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing
files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has
been removed first.
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Troubleshooting

1. Windows VISTA can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in
the INF files for the driver. The VID and PID programmed into the device EEPROM may be found by using
the USB View utility from the FTDI web site. These can then be checked against the VID and PID entries in
the driver INF files. If they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the INF files. Please note
that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by the
customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom
devices". These devices are not usually displayed in the device manager, but can be made to be displayed
as though they are attached. This allows device properties to be changed or devices to be uninstalled via
Device Manger even though the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel >
System" then select the "Advanced" tab and click "Environment Variables". In the System Variables section
(NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

-

Edlit System Variable ===
Variable name: DevMgr_Show_MNonPresent_Dewvices
Variable value: f
[
[ ox || cancel

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then
click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device

Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices".
Device Manager will then show all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, Win 8) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

& windows Security

@ Windows can't verify the publisher of this driver software

«» Don’t install this driver software

You should check wour manufacturer's websike For updated driver softiware For your
device.

=% Install this driver software anyway

Only instal driver software obkained from vour manufacturer's website or disc.
Unsigned software from ofher. sources maty harm your computer o steal information.

j See datais

If you are certain of the source of the driver the warning can be ignored and you can continue installation by
selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64
VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work
with VID 0403 and PID 6001 for FT232 and FT245 devices. It will also work with VID 0403 and PID 6010 for

FT2232 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the
driver will not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The
driver is now available in disk image (.dmg) format. Run the installer by double clicking on the
FTDIUSBSerialDriver.dmg icon.

FB (& N Install FTDIUSESerialDriver Kernel Extension

= _

Welcome to the FTDIUSESerialDriver Kernel Extension Installer

| Welcome to the Mac 05 X Installation Program. You will be

© Introduction guided through the steps necessary to install this software,
@ 'r—‘:-_:'acl Me

@ Select Destination

@ Installation Type

@ Installing |

@ Finish Up /]

h

Go Back { Continue )

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.
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rB L& Rl Install FTDIUSBESerialDriver Kernel Extension i

E Install Software
© Introduction
a Ih\a-n.d Me
© Select Destination
2 Installation Type
© Installing The software was successfully installed

© Finish Up A B

| Click Restart to finish installing the software.

_

When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in
the /dev directory:

/dev/cu.usbserial-xxxxxxxx
/dev/tty.usbserial-xxxXxxxxx

Where xxxxxxxx is either the device's serial humber or, for unserialized devices, a location string that
depends on which USB port your device is connected to. The Terminal application can be launched by
selecting Go > Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce
the file list:

cd /dev
Is-1

If you run the application System Preferences and select Network (Go > Applications > System Preferences
> Network), you should see the text "New Port Detected".
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. . New Port Detected
ﬂ ﬁ A new network port has been detected:

ushserial-1822

Please verify that it is configured correctly, then

press Apply Mow to activate i,

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this
screen by checking the on box and clicking Apply Now.

@6 N Network =

Location: | Automatic @

Show: | Network Port Configurations 8

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

| On | Port Configurations
E Internal Modem
E Built=in Ethernet

N

Delete. ..

it

Duplicate

@

| S
iﬂ Click the lock to prevent further changes. {: Assist me... ) [ Apply Now _:]
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up
a modem for an Internet connection, select the new port from the show list to display the window below.

-Yala Metwork (=]

: = a6 o

Show All  Displays Sound | Mebwork | Startup Disk

Location: Automatic

LR
P

Show: | usbserial-1822

L PPP . TCP/IP  FProxies Modem '

Service Provider: {Dptional)

Account Mame:

Password:

Telephone Number:

Alternate Number: (Dptional)

| Save password
Checking 175 box allows all users of this computer 1o
access this Internet account without entering a password.

( PPP Options... ) ( Dial Now...

@

-

i _. .
J'g Click the lock to prevent further changes. { Assist me... ) Apply Moy

Entries for this screen are specific to the Internet account for each user. If you do not know the required

details, contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat

this installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or

appropriate versions from FTDI Web site:
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username
that has the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting
Network Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled
port and click Delete. Confirm the deletion to remove the port.

r =z |
86 n Network =
¢« = A G E
! Fam b= s '—J
Show Al Displays Sound Metwork Startup Disk
Location: | Automatic ﬂ
Show: Network Port Canﬁgurations F H

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations

bserial-182 -

E[ Internal Modem '-Jﬂ_-'
™  Built-in Etheret ,i Edit
[ Delete... )
@
'] 4‘ Click the lock to prevent further changes. [ Assist me... . Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be
accessed by going to the Finder and selecting Applications from the Go menu, then open the Utilities folder.
Select USB under Hardware in the pane to the left and then select the appropriate device from the USB
Device Tree. In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI
Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

"

006 System Profile B
Andy's eMac 10/01/2005 Qb 37
Conlents LISE Device Tree
¥ Hardware USE Bus
Mermary wUSE Bus
PCIAGP Cirds ¥ Hub in Apple Extended USB Keyboard
ATA
5C51 Apple Optical USE Mouse
(F:] Apple Exterded USE Keyboard
FireWire USE Bus
AirPart Cand USE High-5Speed Bus
Modems
¥ Sofvware
Applications -
il USE <-> Serial
Metwork
Logs « Wendor Name:  FTDI
Speed: Up 1o 12 Mb/sec
Praduct 1D 24577 (36001)

Eus Power {ma} 100

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the
driver. If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is
not 0x0403, it is likely that the device is not an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port Detected" is not
displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the
device reverts to its default device ID, then replug. To get support for your device ID built into FTDI
USBSetrial Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported in FTDI USB
Serial Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check
that the driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial
Driver is not wheel. To change the group, login as root and perform the following script in a Terminal window
(Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.

4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal window
is equivalent to a DOS prompt in Windows.
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6. Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any
representations or warranties (implied or otherwise) regarding the accuracy and completeness of this
document and shall in no event be liable for any loss of profit or any other commercial damage, including but

not limited to special, incidental, consequential, or other damages.
No part of this document may be reproduced or transmitted in any form by any means, electronic or
mechanical, including photocopying, recording or information recording and retrieval systems without the

express written permission of the manufacturer.
All brand names and product names used in this document are trademarks, or registered trademarks of their

respective holders.

CE/FCC & Recycling Information

CE Certification

This equipment complies with the requirements relating to Electromagnetic Compatibility Standards
EN55022/EN55024 and the further Standards cited therein. It must be used with shielded cables only.

It has been manufactured under the scope of RoHS compliance.

FCC Certification
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
You are cautioned that changes or modification not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.
This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation

WEEE (Waste of Electrical and Electronic Equipment),
=== Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and electronic
equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these products must

enter the recycling process.
Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways. Please
follow your national law when you want to dispose of any electrical or electronic products. More details can be obtained from

your national WEEE recycling agency.

CERE

65



	UTS-485UI (RJ-45 Male Connector)
	Windows OS Installation Guide

